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Welcome

The InTouch HMI Tag Viewer utility enables you to monitor tags and 
modify tag values at run time. This guide explains how to enable and 
start the Tag Viewer, navigate in the Tag Viewer interface and use it 
to search for tags, view tags, modify tag properties, and add and 
manage Tag Viewer watch windows.

You can view this document online or you can print it, in part or whole, 
by using the print feature in Adobe Acrobat Reader.

This guide assumes you know how to use Microsoft Windows, 
including navigating menus, moving from application to application, 
and moving objects on the screen. If you need help with these tasks, 
see the Microsoft Help. 

In some areas of the product, you can also right-click to open a menu. 
The items listed on this menu change, depending on where you are in 
the product. All items listed on this menu are available as items on the 
main menus. 

Documentation Conventions
This documentation uses the following conventions:

Convention Used for

Initial Capitals Paths and file names.

Bold Menus, commands, dialog box names, and 
dialog box options.

Monospace Code samples and display text.
InTouch HMI Tag Viewer Guide
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Technical Support
Wonderware Technical Support offers a variety of support options to 
answer any questions on Wonderware products and their 
implementation.

Before you contact Technical Support, refer to the relevant section(s) 
in this documentation for a possible solution to the problem. If you 
need to contact technical support for help, have the following 
information ready:

• The type and version of the operating system you are using.

• Details of how to recreate the problem.

• The exact wording of the error messages you saw.

• Any relevant output listing from the Log Viewer or any other 
diagnostic applications.

• Details of what you did to try to solve the problem(s) and your 
results.

• If known, the Wonderware Technical Support case number 
assigned to your problem, if this is an ongoing problem.
InTouch HMI Tag Viewer Guide
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Chapter 1

Getting Started with Tag
Viewer

Tag Viewer is an external application that allows you to watch and 
monitor tags and modify tag values at run time. It provides you with a 
list of all available tags in the application arranged hierarchically, 
based on their alarm groups. You can run Tag Viewer only when 
WindowViewer is running. Tag Viewer displays only the tags available 
in the local InTouch application and does not support remote 
references.

To use Tag Viewer, you must first enable it in WindowMaker. You can 
then launch the application at run time. You can open only one 
instance of Tag Viewer at a time. 

Enabling Tag Viewer 
You can configure the WindowViewer properties at design time to 
enable Tag Viewer to run. You can also configure the WindowViewer 
menu so that the Tag Viewer option is displayed in the Special menu. 

After you modify these properties, you must restart WindowViewer for 
your changes to become effective, if WindowViewer is already open.

To enable Tag Viewer

1 Open WindowMaker.

2 On the Special menu, point to Configure, and then click 
WindowViewer. The WindowViewer Properties dialog box 
appears.

3 Click the General tab.
InTouch HMI Tag Viewer Guide
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4 In the WindowViewer Startup area, select the Enable Tag Viewer 
check box so that you can start the Tag Viewer. This check box is 
not selected by default. 

5 In the Minimum Access Level box, configure the security access 
level required to run the Tag Viewer application. The default value 
is 9999, and you can type any value between 0 and 9999. 

Note:  If your access level is less than the minimum access level, you 
cannot start Tag Viewer at run time.

6 Click the Window Configuration tab.

7 In the Menus area, select the Tag Viewer check box to enable the 
Tag Viewer option in the Special menu of WindowViewer.

8 Click OK.

9 After you modify any of these parameters, you must restart 
WindowViewer to apply your changes.

Starting Tag Viewer
You can start Tag Viewer only if WindowViewer is running, and Tag 
Viewer has been enabled at design time. You can launch Tag Viewer 
from the WindowViewer menu or from a script calling the 
LaunchTagViewer() function. This function can be executed from any 
script type, except application scripts: OnStartup and OnShutdown. If 
Tag Viewer is not enabled, calling the function will not start Tag 
Viewer and a warning message will be logged in the logger. 
InTouch HMI Tag Viewer Guide
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Security
You must have adequate security privileges to run Tag Viewer. The 
following tables explains the InTouch user security levels that are 
available.

If you are opening an InTouch application, you must log on again to 
re-authenticate yourself to run Tag Viewer. For more details on 

configuring users, see InTouch® HMI Application Management and 
Extension Guide, “Managing Users and Setting Their Authorization 
Level” section on page 144. 

Note:  You do not have to log on again if the security level of InTouch 
is None. 

Security Level Description

ArchestrA If you select this option, you must do the following: 

1 In the WindowViewer Properties dialog box, set Access Level >= 
Minimum Access Level. 

2 Log on to WindowViewer and start Tag Viewer. 

This is applicable if you are running a managed InTouch application.

InTouch If you select this option, you must do the following: 

1 In the WindowViewer Properties dialog box, set Access Level >= 
Minimum Access Level. 

2 Log on to WindowViewer and start Tag Viewer. 

This is applicable if you are running a stand-alone InTouch application.

None If you select this option, then any user can start Tag Viewer at run time 
without logging on to WindowViewer.

OS If you select this option, you must do the following: 

1 In the WindowViewer Properties dialog box, set Access Level >= 
Minimum Access Level. 

2 Log on to WindowViewer and start Tag Viewer.

This is applicable if you are running a stand-alone InTouch application.
InTouch HMI Tag Viewer Guide
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To log on 

1 Open WindowViewer. 

2 On the Special menu, click Security, and then click Log On. 

3 Log on with a valid user ID, password and the required minimum 
access level.

Note:  You can log on as administrator or create a user ID that has 
adequate privileges. 

To start Tag Viewer

1 Open WindowViewer. 

2 On the Special menu, click Tag Viewer. The Tag Viewer appears.

To start Tag Viewer from a script

1 Open WindowMaker. 

2 Configure any script except application scripts “On Startup” and 
“On Shutdown” with the LaunchTagViewer() function. 

3 Open WindowViewer. 

4 Execute the script to start Tag Viewer.
InTouch HMI Tag Viewer Guide
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Navigating in Tag Viewer
The Tag Viewer window contains three parts:

• The left pane, which displays the tags in a hierarchical structure, 
based on their alarm groups

• The right pane, which displays the list of all available dotfields for 
the tag or alarm group selected on the left pane

• The watch window at the bottom, which displays the run-time 
values of tags that you want to monitor.

Closing Tag Viewer
Tag Viewer can be closed in the following ways: 

• By closing Tag Viewer 

• By closing WindowViewer

• By changing the logged-on user

Watch window

Left pane Right pane
InTouch HMI Tag Viewer Guide
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Chapter 2

Using Tag Viewer

You can use Tag Viewer at run time to: 

• Search for tags

• View tags

• Modify tag properties

• Add and populate watch windows

• Manage watch windows
InTouch HMI Tag Viewer Guide
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Searching for a Tag
You can use the Find dialog box to search for specific tags in 
WindowViewer.

To search for a tag 

1 On the Edit menu, click Find Tag/Alarm group. The Find dialog 
box appears.

2 In the Find What box, enter the name of the tag or alarm group 
that you want to find. By default, this displays the last tag or 
alarm group for which you have searched. The Find What box also 
maintains search history. If you are searching for a tag or an alarm 
group for the first time, the Find What box will be empty. 

Note:  The search history is removed when you close Tag Viewer. 

3 In the Search Criteria area, select one of the following: 

• Starts with: Select this option to find a tag or alarm group that 
begins with the text you entered in the Find What box. By 
default, this option is selected. 

• Contains: Select this option to find a tag or alarm group that 
contains the text you entered in the Find What box.

• Exact match: Select this option to find a tag or alarm group 
that matches the text you entered in the Find What box. 

• Ends with: Select this option to find a tag or alarm group that 
ends with the text you entered in the Find What box.

4 In the Type area, select one of the following: 
InTouch HMI Tag Viewer Guide
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• Tagname: Select this option to find a tag. By default, this 
option is selected.

• Alarm group: Select this option to find an alarm group.

5 In the Parent Alarm Group box, enter the name of the alarm group 
to which the tag belongs. If you retain $System, which is the 
default value, the system does not filter the search result by any 
alarm group.

6 Click Find. The list of tags or alarm groups appears.

7 In the search result, double-click the tag name to select it in the 
Tag Viewer. 

Note:  To add the tag to the watch window, click Add to Watch.

Performing a Quick Search
Tag Viewer allows you to search for a tag quickly, if required. 

To perform a quick search

1 In the search box above the left pane, enter all or part of the tag 
name.

Note:  The search box also maintains search history until you close Tag 
Viewer.

 

2 Press Enter or click the search icon. The system selects a tag that 
begins with the text you entered.

Note:  If the text you entered begins with a wildcard (*), the system 
will find any tag name that contains the text.

3 Click the search icon again to resume your search. 

Note:  You can also enter the text and press F3 to perform a quick 
search.
InTouch HMI Tag Viewer Guide
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Managing Tags
Tag Viewer allows you to watch tags and monitor their values at run 
time. You can view all tags available in the application. The tags are 
arranged in a tree structure, based on their alarm groups. 

Viewing Tags
You can view the details of tags in Tag Viewer.

To view tags

1 Open Tag Viewer. 

2 On the left pane, view the list of tags available in the application.

Note:  Tag Viewer displays the tags available in the InTouch application 
only and does not support remote references.

3 On the left pane, click a tag to view its details on the right pane. 
The following information appears:

• Dotfield Name: Displays the dotfields of the selected tag or 
alarm group. 

• Value: Displays the value of the dotfield. If you click the 
dotfield, the value is updated. 

• Type: Displays the dotfield type like integer, discrete.

• Read/Write: Indicates whether the tag is a read-only tag or can 
be modified. 

4 Add a tag to the Watch window to view its dotfield values at run 
time. For more information on adding tags to the Watch window, 
see "Adding a Tag or a Dotfield to a Watch Window" on page 19 in 
this addendum.

Modifying Tag Properties
You can modify the properties of a tag in Tag Viewer. You can modify 
the properties of a tag only if the dotfield is marked as Read/Write or 
Write Only. You cannot modify any tag if you are running 
WindowViewer on a read-only license. 

You will be asked to re-authenticate yourself if you try to modify the 
following: 

• An indirect tag that is pointing to a Galaxy attribute, which is 
configured with Secured Write. 

• An indirect tag that is pointing to a Galaxy attribute, which is 
configured with Verified Write. In this case, you must provide the 
log on details of the additional user too. 
InTouch HMI Tag Viewer Guide
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To modify tag properties

1 Open Tag Viewer. 

2 On the left pane, click the tag to modify its properties. The tag 
details are displayed on the right pane.

3 Do any of the following: 

• On the right pane, click the property, and then click Go on the 
toolbar. The Tag Reference dialog box appears.

• In the Type list, select the tag type, and change the value. 

Double-click any value on the right pane if you want to change 
the data type of the dotfield. The Modify dialog box appears. 
The dialog box varies depending on the data type of the 
dotfield. You can modify the value of the following data types: 

Discrete Value: You can click True or False.

Number: You can enter any number between 
-2147483648 and 2147483647.
InTouch HMI Tag Viewer Guide
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Message: You can enter any text message upto 131 characters.

• Right-click the item, and then click Modify. The Modify dialog 
box appears. Modify the value.

4 Click Apply. The value is changed.

Managing Watch Windows
The watch window is displayed at the bottom of the Tag Viewer by 
default. You can use this window to view the value of tags at run time. 
You can create additional watch windows to group relevant tags 
together. You can also remove a watch window, if required.

Adding a Watch Window
You can create additional watch windows if you want to group tags 
and view them. The new watch windows are added as tabs next to the 
default watch window. You can create upto 50 watch windows. 

To add a watch window

1 Right-click the watch window, and then click Add Watch Window. 
The new watch window is added. By default, it is called Watch List 
<n>. 

Note:  To rename the watch window, right-click the watch window tab 
and click Rename Tab. 

2 Add tags to the watch window, as required.

3 Move from one watch window to another by clicking the tabs.
InTouch HMI Tag Viewer Guide
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Adding a Tag or a Dotfield to a Watch Window
You can add tags or dotfields to a watch window to monitor their 
values at run time. You can add upto 2000 tags or dotfields to a watch 
window. 

Note:  If you add an alarm group to a watch window, all tags under 
this alarm group are added to the watch list.

To add a tag to a watch window

1 Do any of the following: 

• On the left pane, right-click the tag and click Add to Watch. 
The tag is added to the watch window.

• On the left pane, click the tag and drag and drop it to the watch 
window.

• Right-click the watch window and click Add Tag Reference. 

• On the right pane, right-click any dotfield and click Add to 
Watch. The dotfield is added to the watch window.

Note:  You can select multiple tags or dotfields and add them to the 
watch window.

2 Click any column header to sort the table, based on the column in 
ascending or descending order.

Adding a Separator to Group Tags
You can group similar tags by adding a separator after a group of tags. 
If you save a watch window, the separators in the watch window are 
automatically saved. 

To add a separator to group tags

1 On the watch window, click the row after which you want to add 
the separator. 

2 Right-click the watch window, and click Add Separator. The 
separator is added after the selected row. 

3 Select the separator along with the tag references and drag and 
drop them to another location to change the order of tags in the 
watch window.

Note:  If you sort the information on the watch window the separator 
is removed. 
InTouch HMI Tag Viewer Guide



20  Chapter 2  Using Tag Viewer
Backing up and Restoring Watch Windows
You can save a set of watch windows as a back up and load them again 
when required. 

Saving a Set of Watch Windows
You can save all the watch windows that you have opened, if required. 
You can later load this set of watch windows and monitor the tags.

To save a set of watch windows

 On the File menu, click Save Watch List and save the watch 
windows. By default, InTouch saves the watch windows in the 
Watch Lists folder in the current application directory. 

Note:  To save the watch windows in a different location, click Save 
Watch List As on the File menu.

Loading a Set of Watch Windows
You can open any watch window that you have saved earlier. 

To load a watch window

1 On the File menu, click Load Watch List. The Select a File dialog 
box appears.

Note:  You can also right-click the watch window and click Load Watch 
List. 

2 Browse to the location where the file is saved and open the file. 

Note:  On opening a watch window, the existing windows are replaced 
with the new one. Only the references that are valid in the current 
application are added to the watch window. 

I/O References
I/O references or indirect tags that are displayed in Tag Viewer behave 
like the windows in WindowViewer.

• If you remove an I/O or indirect tag from the watch window, the 
I/O reference is unsubscribed. 

• If you have not added an I/O or indirect tag to the watch window, 
but its dotfield has been refreshed or you have clicked the tag on 
the left pane, Tag Viewer subscribes to the I/O reference. The 
subscription remains as long as the tag remains selected.
InTouch HMI Tag Viewer Guide
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• If you close Tag Viewer, all I/O or indirect tags subscribed by Tag 
Viewer are unsubscribed.

• Closing Tag Viewer or removing tags from the watch window has 
no impact on tags in WindowViewer.

Persistence of Tag Viewer
Tag Viewer should be persistent with respect to its InTouch 
application in terms of the following:

• Location and size of the main window.

• Size of the tag tree structure on the left pane, the dotfield list on 
the left pane, and the watch window.

Tag Viewer should be persistent with respect to its WindowViewer 
session in terms of the following:

• Selected tag on the left pane

• Watch window

• Status bar and tool bar

Note:  The persistence with its WindowViewer session is removed 
when you close WindowViewer. 

Watch Window File Format
The watch window file that you have saved uses XML file format. The 
XML schema is: 

<?xml version="1.0" encoding="utf-8"?>

<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema">

  <xs:element name="InTouchTagViewer">

    <xs:complexType>

      <xs:sequence>

        <xs:element name="Watch" minOccurs="1" 

maxOccurs="unbounded">

          <xs:complexType>

            <xs:sequence>

              <xs:element name="ReferenceString" type="xs:string" 

minOccurs="0" maxOccurs="unbounded"></xs:element>

              <xs:element name="Separator" minOccurs="0" 

maxOccurs="unbounded"></xs:element>

            </xs:sequence>

          </xs:complexType>
InTouch HMI Tag Viewer Guide
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        </xs:element>

      </xs:sequence>

    </xs:complexType>

  </xs:element>

</xs:schema>
InTouch HMI Tag Viewer Guide
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Chapter 3

Understanding Error
Messages

Tag Viewer displays error messages when it fails to execute a request. 
The message is displayed in a dialog box, which contains the 
description of the error.

Main Window
Feature Description Reason

Quick 
Search

The searched tagname/alarm group was 
not found.

System could not find a matching 
tagname/alarm group.

Watch 
window

The maximum number of references that 
can be added to watch window is 2000.

You have tried to add more than 2000 
items to a watch window. 

The maximum number of watch windows 
is 50.

You have tried to add more than 50 
watch windows.

<File1> is not a valid watch list file. You have specified an invalid file 
name while opening a watch window.

<File1> already exists. Do you want to 
replace it?

You have specified an existing file 
name while saving a watch window.

The following references does not exist in 
the current InTouch application and they 
were not added to the watch window:

<List of references>

Some of the references that you loaded 
in the watch list are invalid or do not 
exist in the current InTouch 
application. 
InTouch HMI Tag Viewer Guide
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Add Tag Reference

Modify Tag Value

Feature Description Reason

Add Tag 
Reference

Cannot find <f> in <abcd>. You have entered a string <f> in the 
Substitute box and this string is not 
part of the string <abcd> in Tag 
Reference.

The <From> value cannot be greater than 
<To> value.

You have entered a number in the 
To box that is less than the number 
in the From box.

Please enter a number for <From>.

Or,

Please enter a number for <To>.

You have entered a string in the 
Substitute box, but the From box 
or To box is empty.

The following references does not exist in 
the current InTouch application and they 
were not added to the watch window:

<List of references>

You have entered one invalid 
reference or multiple references and 
some of the references are invalid.

The maximum number of references that 
can be added to watch window is 2000.

You have tried to add more than 
2000 items to a watch window. 

Feature Description Reason

Modify 
Integer Value

<1a> is not a valid numeric 
value.

You have entered an invalid entry <1a> in the 
Value box and clicked Apply. 

The input value is out of 
valid range for integer data 
type.

You have entered a number that is outside 
the permitted range (-2147483648 and 
2147483647).

Modify Real 
Value

The input value is out of 
valid range for real data 
type.

You have entered a value that is outside the 
permitted range (-3.402823466e38 and 
3.402823466e38)
InTouch HMI Tag Viewer Guide
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Rename Watch Window

Tag Reference 
dialog box

The tag reference 
<InvalidReference> does not 
exist in this application.

You have entered a value <InvalidReference> 
in the Tag Reference dialog box and clicked 
OK.

The data to be set was of the 
wrong data type.

The reference was a read-only tag, and you 
tried to modify the value.

Or, 

You have entered a value that is not valid for 
the selected type of the tag reference. 
For example, you have entered a string type 
value while modifying an integer type tag. 

Feature Description Reason

Watch 
Window

Watch window <Watch List 1> 
already exists.

You have entered an existing name while 
renaming a watch window.

“ReadonlyReference” is read only 
and cannot be modified.

You have added a read-only tag in the 
watch window and double-clicked the tag 
to modify the value.

Feature Description Reason
InTouch HMI Tag Viewer Guide
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application A collection of objects in a Galaxy Repository that performs an 
automation task. Synonymous with galaxy. There can be one or more 
applications within a Instance.

ArchestrA The distributed architecture for supervisory control and 
manufacturing information systems. It is an open and extensible 
technology based on a distributed, object-based design.

Area A logical grouping of AutomationObjects that represents an area or 
unit of a plant. It is used to group related AutomationObjects for 
alarm, history, and security purposes. It is represented by an Area 
AutomationObject.

attribute An externally accessible data item of an automation object.

galaxy The entire application. The complete ArchestrA system consisting of a 
single logical name space (defined by the Instance) and a collection of 
Platform objects, Engine objects and other objects. One or more 
networked PCs that constitute an automation system. This is referred 
to as the Galaxy Namespace.

instance An object, which is a unique representation of a template that exists in 
run time.

Log Viewer A Microsoft Management Console (MMC) snap-in that provides a user 
interface for viewing messages reported to the LogViewer.

object Any Template or instance in an Instance. A common characteristic of 
all objects is they are stored as separate components in the Instance.

PLC Programmable logic controller.

properties Data common to all attributes of objects, such as name, value, quality, 
and data type.

reference A string that refers to an object or to data within one of its attributes.
InTouch HMI Tag Viewer Guide
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remote reference The ability to redirect ArchestrA object references or references to 
remote InTouch tags. The new script function that redirects remote 
references at run time is IOSetRemoteReferences.

security Industrial Application Server security is applied to IDE, System 
Management Console (SMC), and the run time data level. At the run 
time data level which centralizes the definition of all permissions to 
the ArchestrAs. These ApplicationObjects can be accessed by a variety 
of clients but the security is centrally defined, allowing ease of 
maintenance. Users that are allowed to modify these 
ApplicationObjects at run time are mapped to the objects by user-
defined roles. These roles can be mapped directly to existing groups in 
a Microsoft Domain or workgroup. 

Tagname The unique name given to an object. For example, for a given object, its 
TagName = V1101 and its HierarchicalName = 
Line1.Tank1.InletValve.
InTouch HMI Tag Viewer Guide
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